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Microsoft Vista and Office 2003-2008 

 
What is Vista? 

 

Vista is a Microsoft Windows Operating System (OS). Your software applications (Adobe Acrobat, Flash, 

Dreamweaver, SPSS, SAS, Microsoft Office, and others) work on top of the operating system named 

Microsoft Vista. Examples of older Windows operating systems are: 

• Windows XP 

• Windows 2000 

• Windows NT 

• Windows Millenium 

• Windows 98 

 

While the date has not been set for the Buffalo State College campus upgrade, it is likely to begin in 

2008/2009. Faculty lab coordinators, and others, will be contacted prior to conversion to assist with 

software testing.  

 

What is Microsoft Office and what do all those numbers mean? (2003, 2004, 2007, 

2008): 

 

Microsoft Office is a group of software applications that most of us use every day. They include Microsoft 

Word, Microsoft Excel and Microsoft PowerPoint among others. Currently, most campus owned Windows 

computers run Microsoft Office 2003. Most campus owned Apple (Mac) computers run Microsoft Office 

2004. These two programs are compatible and documents created on one can usually be opened by the 

other. 

 

Microsoft has upgraded Office 2003 to Office 2007 for Windows computers and from Office 2004 to Office 

2008 for Apple (Mac) computers. Office 2008 for the Mac is set to be released sometime in early 2008. 

 

Why does it matter? 

 

This matters because new Windows computers are shipping with the Vista operating system. Customers 

who elect to purchase Microsoft Office for their new computer will receive the new edition, Microsoft Office 

2008.  

 

Sometimes the old version of your software won’t work with the new Vista operating system. This is of 

concern to us, and we want to have time to let you test your software in a Vista environment. Plans for 

that are being developed. 

 

Most campus owned windows computers use Windows XP and Microsoft Office 2003. Remember, Microsoft 

Office is a suite of Word, PowerPoint and Excel, among others. Word 2007 can read a Word 2003/4 file, 

but Word 2003/4 can not read a Word 2007 file. 

 

All files have different file extensions and this causes problems when one attempts to download and then 

open a file created in Office 2007 using Office 2003. Here’s a glimpse of the differences: 

 

Microsoft Office File Name Extension Chart 

 Office 2000/XP/2003 Office 2007 

Microsoft Word  .doc .docx 

Microsoft Excel .xls .xlsx 

Microsoft PowerPoint .ppt .pptx 

Microsoft Access .mdb .accdb 
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General Solutions for Campus Owned and Personally Owned Windows Computers: 

 

All campus Windows machines are loaded with a “converter” that automatically converts Office 2007 files 

so that they can be read by Office 2003. If you use a campus owned Windows machine that does not have 

this ability, you must call the device name in to the Computing Help Desk (x4357) so that we can correct 

the problem. 

 

If you need to download and install the converter for your own home computer, you can access 

it at this link: 

http://office.microsoft.com/en-us/word/HA100444731033.aspx 

 

A converter for Macintosh computers should be available in 1-2 months and will be automatically deployed 

by the Desktop Systems group. Deployment will be published in the Buffalo State publication, The Daily. 

 

Specific Solutions for Document Preparation/Sharing: 

 
 

Application Solution 

Microsoft Word  1. Save file in Rich Text Format (.rtf) 

2. Word 2007 users save file as Word 2003 file 

3. Use Google Docs 

4. Save as PDF 

Microsoft Excel 1. Excel 2007 users save file as Excel 97-2004 file 

2. Use Google Docs 

3. Save as PDF 

Microsoft PowerPoint 1. Save as PDF 

2. Use Google Docs 

Microsoft Access 1. Currently Investigating Options 

 

Help Documents for Students: 

 

Documents that tell students how to save their file in Rich Text Format (.rtf), and in the older version of 

Word, are on the CTS Web site in the For Students section under the heading Support. Once there, select 

the link Help Documents. 

http://www.buffalostate.edu/cts/x689.xml 

 

You may link to this site from your syllabus or to the specific document (Convert Word 2007 files to Rich 

Text Format).  

 

Help Documents for Faculty: 

 

Help documents for faculty are currently located here: 

http://www.buffalostate.edu/cts/x737.xml 

 

 

Help with Google Docs and Applications in General 
 

The Application Support Desk is located in Butler Library next to the Computing Help Desk. Please stop by 

for assistance setting up Google Docs for your classes. Faculty, staff and students may also stop by the 

desk for assistance with computing applications. 
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Future Plans: 

 

CTS hopes to roll out Office 2007 in spring 2008 by placing both Office 2003, and Office 2007 on your 

desktops. Stay tuned for information about training and default settings.  

 

Once the campus moves to Vista, Office 2003 will no longer be available. Training for Office 2007 will be 

available beginning in Februaray 2008 and throughout summer and fall 2008. Start dates for training for 

Office 2008 (Mac users) will be announced once the software is released and we are ready to train. 
 

 

Example Documents: 

 

See attached. 
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This document is for students and faculty and is available on the CTS Web site in both the  

For Students section and the For Faculty section under Support/Help Documents 
 

How To: Convert Word 2007 files to Rich Text Format (RTF) 
 
Word 2007 introduces a new file format which is incompatible with older versions of Word. Files created with the new version are 
easy to identify because they have file extensions that end with the letter “x.” Word 2007 files end with the .docx extension rather 
than the .doc extension used by previous version of Word. 
 
If someone hasn’t upgraded to the new version of Word, and are still using an older version, they may have trouble opening Word 
2007 files. One workaround is to save the Word 2007 file in Rich Text Format (RTF). Rich Text Format is a format which is fairly 
universal and can be opened by almost any word processing program.  
 
Convert Word 2007 files in Rich Text Format (RTF) format 

The steps below explain how to convert a Word 2007 document in Rich Text Format:  
 
1. Open your file in Word 2007. 

2. Click on the Office Button (top left corner) and select Save As. 

3. When the Save As dialog box opens select Rich Text Format from the Save as type drop-down. 

 
 

4. Enter a name for the file in the File name box. 

5. Click the Save button. 

Note: Rich Text Format files end with the .rtf file extension.  

 
1. Login to ANGEL and download the Word 2007 file to the desktop. 
2. Open My Computer, and click Folder Options from the Tools menu. 
3. Click on the View tab, scroll through the list of options, and make sure Hide extensions for known file types is unchecked (see 

picture below). Click OK. 
 

 
 
4. Close My Computer and return to the desktop. The file extension should now be visible (e.g. filename.doc).  
5. Right-click the file and select Rename from the menu. Add the letter “x” to the very end of the filename (i.e. after the .doc), and 

press Enter. 
6. When you receive the message below, click Yes. 
 

 
 

7. Double-click the file to open it. You should now be able to open the file in Word. 
 
Revised: November 2007  (JPW) 

 
 
 
 



Computing Help Desk @ Buffalo State College 

Butler Library Reference Room | Phone: (716) 878-4357 

      

Computing and Technology Services 
www.buffalostate.edu/cts 

 
 

This document is for students and faculty and is available on the CTS Web site in both the  

For Students section and the For Faculty section under Support/Help Documents 
 

 

How To: Open Office 2007 files downloaded from ANGEL 
 
Office 2007 introduces a new file format which is incompatible with older versions of Office. Files created with the new version of 
Office are easy to identify because they have file extensions that end with the letter “x.” For example, Word 2007 files end with the 
.docx extension. This differs from files created with previous version of Word, which end with the .doc extension (see chart below). 
Access 2007 files are the exception; they end with the .accdb file extension. 
 

Microsoft Office File Name Extension Chart 

 Office 2000/XP/2003 Office 2007 

Microsoft Word  .doc .docx 

Microsoft Excel .xls .xlsx 

Microsoft PowerPoint .ppt .pptx 

Microsoft Access .mdb .accdb 

 
ANGEL users who use the Internet Explorer (IE) browser may experience trouble opening Microsoft Office 2007 files after 
downloading them from ANGEL. The reason is that ANGEL, when used with IE, replaces the .docx extension with the older 
extension (.doc). This makes the file unusable. ANGEL users with older versions of Microsoft Office may also experience trouble 
opening files created with Microsoft Office 2007, regardless of what browser is used (i.e. Internet Explorer, Mozilla Firefox, etc). 
 
The resolution for this problem is relatively easy. Office 2007 users should follow the steps outlined in Resolution 1 below before 
uploading files to ANGEL. If files have already been uploaded to ANGEL using the new Office 2007 file format, follow the steps in 
Resolution 2 to ensure that these files open correctly. 
 

Important! Anyone using an older version of Office – including Office 2003, Office XP, and Office 2000 – must download and 

install the Microsoft Office 2007 Compatibility Pack from the Microsoft website. After installing the compatibility pack, you’ll be 

able to open, edit, save, and create files in the new file format.  

Resolution 1: Save Office 2007 files in Office 2003 format 

To ensure that people with older versions of Office will be able to open their documents, Office 2007 users can simply convert their 
files to the older file format before uploading them to ANGEL. The steps below explain how to save a Word 2007 file in the older 
Word 2003 file format:  
 
6. Open your file in Word 2007. 

7. Click on the Office Button (top left corner). 

8. Go down to the Save As menu and select the Word 97-2003 Document option. 

 
 

9. Enter a name for the file in the File name box. 

10. Click the Save button. 

11. Upload the Word 2003 version of the file to ANGEL.  

 
Note: While Microsoft Word is used in the example above, these steps apply to any of the programs in the Office 2007 suite. The 

Save As menu in Excel includes the option to save as an “Excel 97-2003 Workbook;” PowerPoint includes the option to save as a 

“PowerPoint 97-2003 Presentation;” Access includes the option to save as an “Access 2002-2003 Database.”   

Resolution 2:  Change the file name extension after downloading an Office 2007 file from ANGEL 

If a file has already been uploaded to ANGEL in the new Office 2007 format, and you have trouble opening the file after downloading it 
from ANGEL, follow these steps to resolve the issue:
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8. Login to ANGEL and download the Word 2007 file to the desktop. 
9. Open My Computer, and click Folder Options from the Tools menu. 
10. Click on the View tab, scroll through the list of options, and make sure Hide extensions for known file types is unchecked (see 

picture below). Click OK. 
 

 
 
11. Close My Computer and return to the desktop. The file extension should now be visible (e.g. filename.doc).  
12. Right-click the file and select Rename from the menu. Add the letter “x” to the very end of the filename (i.e. after the .doc), and 

press Enter. 
13. When you receive the message below, click Yes. 
 

 
 

14. Double-click the file to open it. You should now be able to open the file in Word. 
 

Note: While Microsoft Word is used in the example above, these steps apply to any of the programs in the Office 2007 suite. 

(e.g. Microsoft Excel, Microsoft PowerPoint, Microsoft Access).  

 
Revised: November 2007  (JPW) 

 


